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SECTION 6 

INTRODUCTION: 
Advanced GIS Training 
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Welcome 

• Introduction 
– Instructor: Greg Carlino  
– Email: carlinog@gvmc.org 

 

• Attendee Introductions 
– Your Name 
– Department or Group 
– What you do 
– Prior GIS Experience? 
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Logistics 

• Schedule 
– Begin 8:30am 
– Breaks at least every 90 minutes 
– Lunch from about Noon to 1:00pm 
– Finish by 4:00pm or sooner 

• Facilities (REGIS Training Lab) 
– Break Room with refrigerator, Rico’s Deli on 1st 

floor near main entrance. 
– Restrooms near side entrance to REGIS 
– Telephones – available, please ask 
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Overview of REGIS GIS applications 
• Increasing functionality from ArcIMS to ArcView and ArcEditor 
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Overview of ArcGIS applications 
• All ArcGIS products share common applications 
• ArcMap and ArcCatalog 
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ArcMap 
• Primary display application 
• Perform map-based tasks 

– Displaying 
– Editing 
– Querying 
– Analyzing 
– Charting 
– Reporting 
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ArcCatalog 
• A window into your database 
• Browse your data 
• Manage your data 
• Create and view data 

documentation           
(metadata) 
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ArcToolbox 
• Geographic processing 

functions 
– Data management, 

analysis and conversion 
– Tools vary between the 

ArcGIS applications 
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Introduction to ArcGIS Extensions 
• 3D Analyst 

– view a surface from multiple 
viewpoints 

– query a surface 
– determine what is visible from a 

chosen location on a surface 
– create a realistic perspective image 

that drapes raster and vector data 
over a surface 

– record or perform three-dimensional 
navigation.  

– create three-dimensional views 
directly using your GIS data 

– analyze three-dimensional data 
using cut/fill, line-of-sight, and terrain 
modeling 
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Introduction to ArcGIS Extensions 
• Spatial Analyst 

– adds a set of advanced spatial  
modeling and analysis tools 

– you can: 
• find suitable locations 
• find the best path between locations 
• perform integrated raster/vector analysis 
• perform distance and cost-of-travel analyses 
• perform statistical analysis based on the local 

environment, small neighborhoods, or predetermined 
zones 

• generate new data using simple image processing 
tools 

• interpolate data values for a study area based on 
samples; and clean up a variety of data for further 
analysis or display.  
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Introduction to ArcGIS Extensions 
• Network Analyst 

– Network Analyst is a powerful 
extension that provides network-
based spatial analysis including 
routing, travel directions, closest 
facility, and service area analysis.  

– dynamically model realistic network 
conditions, including turn restrictions, 
speed limits, height restrictions, and 
traffic conditions, at different times of 
the day.  

– conduct drive-time analysis, point-to-
point routing, route directions, 
service area definition, shortest path, 
optimum route, closest facility, or 
origin-destination analysis. 
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Help Resources 
• Launch via REGIS Login Page or 
• Launch by pressing F1 in ArcView or by 

going to the Help drop-down menu and 
selecting  ArcGIS Desktop Help. 

• REGIS Help Desk 
– Telephone – 776-7744 
– E-mail – regis@gvmc.org 
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6.1 – ArcGIS I Review 

Section 6 Exercises 
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SECTION 7 

SPATIAL DATA 
INTRODUCTION 
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Features and attributes 
• Feature classes are tables that 

store spatial data 
• Each feature has a record in the 

table 
– Unique identifier links feature 

and attributes 

OID = 16462 
(Feature Identifier) 
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Spatial data formats 
• ArcGIS can work with spatial data in multiple formats 

ArcGIS 

Raster Tables 

Geodatabase 

Internet Map 
Service/ 
ArcGIS 
Server 

Shapefile 

CAD 
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Data format: Shapefile 
• Single feature class  
• Can store points, lines or polygons 
• Attributes stored in dBASE table 

“Shape” field 
accesses separate 

coordinate files 

Donut shapefile 

Shapefile .dbf table 
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Data format: Geodatabase 
• Stores spatial features and their attributes in the same RDBMS 
• Feature classes can be stand-alone or grouped in a feature 

dataset 
• Feature datasets model spatial relationships 

“Shape” field 
accesses separate 

coordinate file 

Coffee 
geodatabase 
feature class 

RDBMS table 



March 2013 REGIS Advanced GIS Training Manual  20 

Data format: CAD files 
• Computer-Aided Design files (.dxf, .dwg, .dgn) 
• Logical collection 

– Access one or all feature class(es) at a time 

• Edit after conversion to shapefile or geodatabase feature class 

“Shape” field 
accesses read-only 

coordinates 

CAD file (read-only attribute tables) 
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Using ArcCatalog 
• Provides a uniform view of all your data 

 
 
 
 
 
 
 
 

• Define or modify table and feature class definitions 
• Manage data: copy, rename, delete 
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ArcCatalog: Three ways to view data 
• Contents 
• Preview 
• Metadata 

ArcCatalog is now on 
ArcMap’s toolbar 
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ArcCatalog: The Contents tab 
• Large icons 
• List 
• Details 
• Thumbnails 

– Data 
– Layers 
– Maps 
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ArcCatalog: The Preview tab 
• Geography or Table view 

– Choose from pulldown menu 
– Build custom views 
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ArcCatalog: The Metadata tab 
• Create and display metadata in a variety of ways 
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Connecting to folders 
• Connect to any folder in your 

network 
 
 
 

• Connect through Network 
Neighborhood to store a Uniform 
Naming Convention (UNC) path 
– Example 

\\servername\foldername\file
name.ext 

– Use UNC in layer files or 
map documents  

• Disconnect from folders 
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7.1 – Using ArcCatalog 

Section 7 Exercises 
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SECTION 8 

SELECTING 
DATA 
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Why do you need a selection? 

Selected 
features 

Convert to graphics 

Edit 

Calculate statistics 

Report 
Export 

Create a new layer 

Use to select 
other features Focused analysis 
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Available selection tools 
• Interactive, attributes, location, 

graphics 

Selected set 

Interactive selection method 

Select features by drawing a polygon 

Selection menu 
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Selection layers 
• Specify from Table of Contents 

tab 
– Layer to select from using 

interactive selection tool 



March 2013 REGIS Advanced GIS Training Manual  33 

Selection methods 
• Specify from Selection 

menu 

Create new 
selection 

 
 
 
 

Add to the 
selection 

 
 
 

Remove from 
the selection 

 
 
 

Select from 
selection 
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Interactive selection options 
• Options from Selection menu 

– Select features partially or completely 
within the box or graphic(s) 
 
 
 

– Select features completely within the box 
or graphic(s) 
 
 
 

– Select features that the box or graphic 
are completely within 
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Attribute selection 
• Use an SQL statement to select 

features 
• Save and reload selection 

expressions For current selection: 
   Add to 
   Remove from 
   Select from 

Field Value 
Operator 
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Select by location (Spatial query) 
• Use features in one layer to select features in another 

Cities intersected by 
selected countries 
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Location selection methods 
• Select by location offers many selection methods 

– Intersects 
– Contains 
– Are contained by 
– Shares a line  
 segment 
– Shares a point 
– Within a distance 
– Are identical 
– Others… 

Polluted areas 
completely within 
selected countries 

Animal sightings 
within a distance 

of 2 km from rivers 
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Select by shape or graphic 
• Draw a shape or graphic to 

select features 
• Works with interactive selection 

methods 
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Calculating summary statistics 
• Select 

– Features 
– Layer 
– Field 
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8.1 – Select Features Interactively 
8.2 – Select By Attributes 
8.3 – Select By Location 
8.4 – Select By Graphics 
8.5 – Using Selections 

Section 8 Exercises 
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SECTION 9 

WORKING WITH 
TABLES 
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Tables 
• Descriptive information about 

features 
• Each feature class has an 

associated table 
• One row for each geographic 

feature 
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Understanding table anatomy 
• Basic table properties 

– Records/rows and fields/columns 
– Column types can store numbers, text, dates 
– Unique column names 

Columns 

Rows 
Attribute 
values 
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Table manipulation 
• Open table in ArcMap or preview 

in ArcCatalog 
– Sort ascending or 

descending 
– Freeze/Unfreeze  
 columns 
– Statistics 

• In ArcMap 
– Select records 
– Modify table  

values 
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ArcGIS tabular formats 
• Each ArcGIS spatial format has a native tabular format 

– Coverage: INFO 
– Shapefile: dbf 
– Geodatabase: RDBMS 

• Create a link between related tables 
• Some spatial formats can link with multiple tabular formats 

ArcGIS can convert between formats } 

landusecov 

landusecov.pat owner.dbf taxinfo_dat 
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Associating tables 
• Can store attributes in feature tables or separate table 
• Associate tables with common column key values 
• Must know table relationships (cardinality) 

Feature attribute table 
Additional 

attribute table 
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Table relationships 
• How many “A” objects are related to “B” objects? 
• Types of cardinality 

– One to one, one to many or many to one, and many to many 

• Must know cardinality before connecting tables 
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Joins and relates 
• Two methods to associate tables 

in ArcMap 
• Join appends the attributes from 

one onto the other based on a 
common field 

• Relates define a relationship 
between two tables 
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Connecting tables with joins 
• Physical connection between two tables 
• Appends the attributes of two tables 
• Assumes one-to-one or one-to-many cardinality 

Soil Soil_desc 

Soil 
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Connecting tables with relates 
• Define relationship between two tables 
• Tables remain independent 
• Additional cardinality choices 

– One to many, many to many 

Open related table 
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Graphs 
• Summarize tabular information 
• A variety of graph formats 
• Set display properties 
• Add to a map 
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Reports 
• Organize and display 

tabular data 
• Group and format data 
• Save and export 
• Three reporting tools 

– Report Writer 
– Crystal Reports 
– REGIS Mailing 

Labels 
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The ArcMap Report Writer 
• Quick, easy, professional report creation 

Add borders 
Title 

Display 
records 

Date and page 
numbers 

Calculate 
summary 
statistics 

Add an image 
Choose fields 
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Crystal Reports 
• A more powerful reporting tool 
• Export to Crystal Reports format 
• Wizard aids in report creation 
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9.1 – Introduction to Tables 
9.2 – Using Tables 
9.3 – Using Field Properties and MapTips 
9.4 – Using Relates 
9.5 – Creating and Using Joins 
9.6 – Creating Graphs 
9.7 – Creating Reports 

Section 9 Exercises 
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SECTION 10 

SYMBOLIZING & 
DISPLAYING DATA 
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Layer symbology in ArcMap 
• Same symbol for all features 
• Based on attribute values 
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Displaying qualitative values 
• Features 

 
 
 
 

• Categories 
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Displaying quantitative values 
• Quantities 

 
 
 
 

• Charts 
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Classifying quantitative values 
• Can modify classes 

Equal Interval 

Quantile 

Natural Breaks 

Standard Deviation 
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Changing the symbol properties 
• Symbology tab or Table of 

Contents 

Left-click 

Right-click 
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Labeling features 
• Label features dynamically using 

attribute values 
• Layer properties control 

appearance and position 
• Convert labels to annotation 

features 
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Creating a definition query (“filter”) 
• Build a query based on attributes 
• Only displays queried features 
• Does not affect source 
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Saving a layer file 
• Save symbology for use in other map documents 
• Layer files 

– .lyr extension 
– Save the display for a layer without saving an entire map 

document 
– Load into another map document 
– Preview in ArcCatalog Further 

Customize 
symbology 

Sources 
Vector 
Raster 
TIN 

Default 
symbology 

Customize 
symbology 

Save 

In map 
document 

(.mxd) 

As a 
separate 
layer (.lyr) 
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10.1 – Introduction to Layer Symbology 
10.2 – Advanced Layer Symbology 
10.3 – Labeling Features 
10.4 – Creating a Definition Query 
10.5 – Creating a Layer File 

Section 10 Exercises 
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SECTION 11 

CARTOGRAPHIC DESIGN 
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Section 11 Overview 
• Basic cartographic concepts 
• Creating maps in ArcMap 
• Printing and plotting maps 
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Map and design objectives 
• Map objectives 

– Share information 
– Highlight 

relationships 
– Illustrate analysis 

results 

• Design objectives 
– Manipulate the 

graphic 
characteristics 

– Fulfill the intended 
purpose 
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Factors controlling cartographic design 

Scale? 
Technical 

limits? 

Mode of 
use? 

Final design 

Need to 
generalize? 

Reality? 

Audience? 
Objective? 
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Communication in maps 
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Types of maps 
• General maps 

– Locational/Positional 
– Variety of features and uses 

 
 
 

• Thematic maps 
– Distribution of an attribute 
– Single attribute or relationship 

 
 
 

• Different objectives, different cartographic designs 

Soils Population 

Qualitative Quantitative 
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Issues in cartographic design 
• Colors, shade patterns and text 

– Perception of colors and symbols 
– Legibility of features and text 
– Visual contrast and hierarchy 

 
 
 
 

• Visual balance 

Size Value 
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Creating maps in ArcMap 
• Design in Layout view 
• Data frames organize 

layers 
• Map elements are 

added to a virtual page 
• Maps stored as .mxd 

files 
– Data location 
– Layer properties 

Data frame Title Neatline 

Legend 

North 
arrow 

Logo Scale 
bar 

Data 
frame Virtual 

page 
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Setting up the page 
• Remember the purpose 

– Will the map be viewed up 
close or at a distance 

– What is the best page size? 
– Landscape or portrait? 
– What printer will I be using 

and what are my printer size 
limitations? 
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Inserting map elements 

 Choose type 

 Legend appears 

 Drag 

 Modify 
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An example of the Legend Properties dialog 
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Adding a north arrow and a scale 

• Change angle, size and 
color 

• Choose type, unit 
increments, color and font 
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Incorporating a reference system 
• Display reference positions on maps 
• Available reference systems 

 
 
 
 
 
 
 

• Different graticule or grid types on the same map 

Graticule  Grid 

Latitude/Longitude, feet, meters, etc. ABC/123, others 



March 2013 REGIS Advanced GIS Training Manual  80 

Inserting textual information 
• Title and author 
• Data source, date, projection 
• Date of map 
• Disclosures and 

acknowledgements 

same 
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Layout tools 
• Zoom and pan the layout 

page 
• Additional layout settings 

from Tools > Options 
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Grids and rulers 
• Determine the size of 

map elements 
• Use guides to arrange 

elements 
• Use grids to position 

elements at specific 
points 

• Use snapping for 
precision and 
efficiency 
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Creating and using map templates 
• Gives all maps in a series the same look 

 
 
 
 
 
 

 
• ArcMap templates 
• Create your own 

Choose a 
standard 
template 
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Printing and plotting maps 

Windows 
printer engine 

Choose a printer engine 
ArcPress 
PostScript 
Windows 
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Exporting maps as digital files 
• Export from Layout view, not Data view! 
• Exports all elements from layout, not just map 
• Export to raster (.gif, .jpeg, .tiff) or PDF formats 
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11.1 – Layout View Overview 
11.2 – Adding Reference Systems 
11.3 – Aligning Elements in Layout View 
11.4 – Using the Draw Toolbar 

Section 11 Exercises 



Exercise 7.1 – Using Arc Catalog 
 
 
In this exercise, you will learn how to: 

♦ Open ArcCatalog and understand the interface 
♦ Connect to a folder to create a directory shortcut   
♦ Preview GIS datasets 
♦ Add data to ArcMap from ArcCatalog 

 
Setup  
Log in to the REGIS Application Web Interface and Launch ArcView 10. 
 
Using ArcCatalog Tutorial 
 

1. ArcCatalog can be opened from within ArcMap. Select the Catalog button  on the 
Standard toolbar. ArcCatalog can also be launched directly from the REGIS 
Application Web Interface.  

 
 

          
 

 
 

2. ArcCatalog has its own table of contents on the left side that is called the Catalog 
Tree. Each drive is displayed with a folder icon that can be expanded to view 
the subdirectories. 

The review panel displays properties and 
details of the selected item in the tree 
view. 
 

“Contents” lists databases, datasets, 
ArcGIS documents, and GIS files. 
 

Connect to file 
folders and 
workspaces. 
 

Catalog tree 
 

Connect to 
ArcSDE 
geodatabases. 
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3. ArcCatalog also allows for the creation of folder shortcuts to save from having to 
drill-down through multiple directories to get a specific location. Press the Connect 

to Folder button  found on the Standard toolbar. 
 

4. In the Connect to Folder window, navigate to  
 

Users$ on ‘na1’ (I:) (referred to as the REGIS I:drive) and find your user folder 
 
And press OK. The folder will now appear as another option in the Catalog Tree. 
 

5. The folder shortcut can be renamed to something more appropriate by right-clicking 
on the name and choosing Rename. 

 
6. Make a shortcut connection to your designated community REGIS I:drive folder. 
 
7. In the main area (also called the review panel) of ArcCatalog, make sure the 

Contents tab is selected. Notice that only GIS-related files appear in the list. 
 

 

 

8. Locate a shapefile and left click on the layer to highlight it. If you cannot locate a 
shapefile ask the instructor and he or she can guide you to a file to view 

 
9. Click on the Preview tab 

 

 
 

10. Use ArcCatalog’s Geography toolbar  to zoom in 
and out, pan, return to full extent, and identify features in the Preview window. 
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11. Next choose a vector dataset and select the Description tab. 
 

 
 

12. If there is metadata for the layer, it will be listed here. For many datasets this tab will 
not contain any information since metadata must be entered by the data creator and 
this is often an overlooked step in GIS.  

 
13. ArcCatalog also shows ArcMap project files in the Contents tab. They can be 

renamed by right-clicking or opened by double left-clicking on the name. 
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14. ArcCatalog can also view Microsoft Excel files. GIS data types (e.g. Coverages, 
Shapefiles, Personal Geodatabases, Rasters, etc.) and tables (e.g. Excel files, DBFs, 
Access tables) can be added to ArcMap directly from ArcCatalog. First make sure 
your ArcCatalog window is small enough to see ArcMap’s window behind it. Then 
select a GIS dataset in ArcCatalog. Left-click and hold on the dataset’s name and drag 
it over to ArcMap’s map area or Table of Contents and release the mouse button. It 
may take several seconds to load but the layer will eventually appear in ArcMap. 

 
 
Additional Information 
 
See the Workspace and dataset management with ArcCatalog section of the ArcGIS 
Desktop Help Manual. 
 

 
 

End of Exercise 7.1 
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Exercise 8.1 – Select Features Interactively 
 
In this exercise, you will learn how to: 

♦ Set the selectable layer(s) 
♦ Select features in the map 
♦ Add and remove features from a selection 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Select Features Interactively Tutorial 

1. An interactive selection begins by choosing which layer or layers the selection will be 
made from. In this exercise, you will be defining the Cities & Township layer in the 
Governmental Units group as the only selectable layer. There are multiple ways to 
define a selectable layer. 

 
Option 1: At the top of the Table of Contents click on the List by Selection button 

. Left click the left polygon to change the selectability of the layer. Make the 
Cities & Townships layer the only selectable layer. 
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Option 2: Click on the List By Drawing Order icon  at the top of the Table of 
Contents. Right-click on the Cities & Townships (in Government Units) layer name, 
choose Selection and select the Make This The Only Selectable Layer option. 

 

 
 

2. Go to the Selection menu, choose the Interactive Selection Method and select the 
Create New Selection option. 
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3. Select the Select Features tool  on the Tools toolbar. Return to the map and left-
click inside of a government unit to select it. It is highlighted with a thicker turquoise 
border.  

 

 
4. Press the Clear Selected Features button  to clear the selection. 

5. With the Select Features tool  still active, left-click and hold to draw a box on 
the map. Be sure the box extends across multiple government units. Release the 
mouse button and every government unit that is touched by the box is selected. 
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6. To verify how many features have been selected, switch to the List by Selection tab. 
The Government Units layer is displayed along with the number of polygons selected 
in parentheses. The selected elements in the Cities & Townships layer are 
displayed below the layer. To easily unselect an element, left click on the circle 

next to the element. 
 

 
7. There are two options for adding to the selection. 
 

Option A: Hold down the SHIFT key and left-click inside another government unit 
that is not selected. 
 
Option B: Return to the Interactive Selection Method options in the Selection 
menu and choose Add to Current Selection. Left-click on the map to remove 
individual government units. 
 

REGIS ArcGIS II Training ▪ Exercise 8.1 – Select Features Interactively ▪ Page 4 



 
 

8. There are three options for removing selected features. 
 
Option A: Hold down the SHIFT key and left-click inside a government unit that is 
already selected. It will be unselected while leaving everything else still selected.  
 
Option B: Return to the Interactive Selection Method options in the Selection 
menu and choose Remove From Current Selection. Left-click on the map to remove 
individual government units from the selection. 
 

 
 

Option C: Left click on the blue circle  in the List by Selection tab in the Table of 
Contents. 

 
9. The final interactive selection method is Select From Current Selection. Left-click 

and hold to draw a box on the map that intersects some of the currently selected 
features. Instead of selecting every feature that intersects the box, only those features 
that were previously selected are selected. 

 

 
 

 
 
Additional Information 
 
See the Selecting features interactively section of the ArcGIS Desktop Help manual. 
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End of Exercise 8.1 
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 Exercise 8.2 – Select By Attributes 
 
In this exercise, you will learn how to: 

♦ Select features based on attribute values 
♦ Create, save, and load query expressions 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Select by Attributes Tutorial 

1. Go to the Selection menu and choose Select By Attributes. 
 

 
 
2. The Select By Attributes window will appear. Complete the following setup steps to 

perform an attribute selection. 
 

a. Choose Cities & Townships (in 
Government Units) in the Layer drop-down 
box. 

 
b. Notice the method drop-down box 

defaults to Create a New Selection. 
 

c. Double left-click on the [NAME] 
attribute to add it to the query window at 
the bottom. 

 

d. Left-click on the equals  button. 
 

e. Left-click on the Get Unique Values 
button to show a complete list of 
government unit names. 

 
f. Double left-click on the City of Cedar 

Springs entry to complete the query 
expression: 

 
NAME = ‘City of Cedar Springs’ 
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3. Press OK to perform the selection. All four polygons that represent the City of Cedar 
Springs are selected in the map. Go to the Selection menu and choose Zoom To 

Selected Features or left click the Zoom to Selected Features button . 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

4. Press the Clear Selected Features button . Use the Go Back To Previous 

Extent button  to return to the full extent of the Government Units layer. 
 
5. Return to the Select By Attributes window and create the following expressions 

using the Cities & Townships (in Government Units) layer. In some cases, it may be 
faster to simply type in the expression in the text box. Use the verify button to 
determine if you have entered a valid query. Press Apply after each one and observe 
the resulting selection on the map. 

 

 

  

Query Expression  Selection Result  #  
COUNTY = 'Ottawa County'  Selects all government units in Ottawa 

County.  
10  

COUNTY = 'Ottawa County' OR 
COUNTY = 'Kent County'  

Selects all government units in either 
Ottawa or Kent counties.  

51  

NAME LIKE '%City%'  Selects every government unit that has 
“City” in its name.  

15  

NAME LIKE '%City%' AND COUNTY 
= 'Ottawa County'  

Selects every City in Ottawa County.  2  

NAME <= 'C'  Selects government units where the name 
begins with A, B, or C.  

8  
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6. After entering one of the above expressions, press the Save button to bring up a Save 
As box. Enter an appropriate name for the query expression and press Save. This will 
save the query to a file that can be loaded at a later date in any ArcMap project by 
pressing the Load button. 

 

 
 
7. Press the Help button at the bottom of the Select By Attributes window. It displays 

an in-depth description of how to build your own custom query. 
 
 
 
Additional Information 
 
See the Using Select By Attributes section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 8.2 
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Exercise 8.3 – Select By Location 
 
In this exercise, you will learn how to: 

♦ Select features based on their spatial location 
♦ Select features that are near other selected features 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Select by Location Tutorial 

1. Begin by making the Cities & Townships layer the only selectable layer. Use any of 
the methods discussed in exercise 8.2 to achieve this. 

 

 
 
2. Make sure your Interactive Selection Method is set to Create New Selection. 
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3. Use the Select Features tool  on the Tools toolbar to select a government Unit. 
 

 
4. In the Selection menu, choose Select by Location. 
 

 
 

5. The Select By Location window appears. In this selection, you will be selecting all 
parcels that are inside the selected 
government unit. Complete the following 
steps to perform the selection. 

 
a. In the first box, choose Select 

features from. 
 
b. Place a checkbox by only the 

Parcels layer in the layers list. 
 
c. Choose Target layer(s) features 

are completely within in the 
Spatial selection method box. 

 
d. In the features in this layer box, 

choose Cities & Townships. 
 
e. Ensure that the Use selected 

features checkbox is checked and 
that it indicates only one feature is 
selected. 
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6. Verify your selection by reading through the steps again in order… “I want to select 
features from the Parcels layer that are completely within the selected feature in the 
Government Units layer.” 

7. Press OK and the selection is performed. Switch to the Selection tab in the Table of 
Contents to see how many parcels were selected. 

 

 
 
8. The parcels layer may have a scale restriction enabled (as indicated by gray 

lettering ) so you may have to zoom in close 
enough to see the selection. 

 

 
 

9. Press the Clear Selected Features button . 
 

10. You will now perform another type of select by location. In this example, you will 
find all parcels within 300 feet of a selected parcel. First set the Parcels layer as the 
only selectable layer. 
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11. Use the Select Features tool  to select a parcel on the map. 
 

 
 
12. Go to the Selection menu and choose Select By Location. Enter the appropriate 

information to match the screenshot on the following page. 
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13. When finished, read over the selection again… “I want to select features from the 
Parcels layer that are within a distance of 300 feet to the selected parcel.” Press OK 
to view the result. 
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14. Repeat the select by location but this time begin by selecting a street segment. Find 
all parcels that are within 100 feet of the centerline. 
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Additional Information  
 
See the Using Select By Location section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 8.3  
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Exercise 8.4 – Select By Graphics 
 
In this exercise, you will learn how to: 

♦ Use the Draw toolbar to create a new polygon graphic 
♦ Change the display properties of a graphic 
♦ Use a graphic to select features 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Select by Graphics Tutorial 

1. Turn on the Draw toolbar by going to the View menu, choosing Toolbars and select 
Draw. 

 
 

 
 
2. Select the black down-triangle next to the New Rectangle button  and choose 

the New Polygon icon . 
 

3. Return to the map and zoom in on a smaller area of parcels. Draw a shape on the map 
by left-clicking on the screen to create polygon vertices (remember that vertices are 
points that allow for polygon boundaries to change direction or shape). Double left-
click on the last vertex of the shape to finish the drawing. This creates a graphic on 
top of the map data. 

 
4. Using the Select Elements tool  on 

the Draw toolbar, right-click on top of 
the newly created graphic and select 
Properties. Select the Symbol tab and 
change the Fill Color to No Color, the 
Outline Color to Red, and the Outline 
Width to 3. 
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5. Press OK and return to the map. Before performing the select by graphic function, 

you first must set the Parcels layer as the only selectable layer. Go to the List by 
Selection tab. 

 

 
 

6. First, make sure the graphic is still selected (notice the dotted rectangle surrounding 
the graphic), then go to the Selection menu and choose the Select by Graphics 

option. If this option is grayed out, use the Select Elements tool  to select the 
graphic and try again. 
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7. The select by graphics command will select all parcels that are intersected by the 
graphic you created. 
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Additional Information  
 
See the Working with graphics section of the ArcGIS Desktop Help manual. 
 

 
 
See the Using Select By Graphics section of the ArcGIS Desktop Help man 
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Exercise 8.5 – Using Selections 
 
In this exercise, you will learn how to: 

♦ Calculate summary statistics on a selection 
♦ Create a new layer from selected features 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Using Selections Tutorial 

1. Set the Street Centerlines grouped layer as the only selectable layers by going to the 
List by Selection in the Table of Contents. 

 

 
 

2. Use the Select Features tool  to select several street segments on the map. 
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3. Go to the Selection menu and choose Statistics. 
 

 
 
4. The Selection Statistics window appears to provide additional information about the 

selected features. Make sure the Layer drop-down box shows a Street Centerlines 
layer. In the field drop-down box, select the SHAPE.LEN field. It is important to 
understand that only numerical fields are available for selection statistics. 

 

 
 
 

5. The Statistics box contains information on how many segments are selected, the 
shortest and longest segments (in feet), the total length, and the average length. A 
Frequency Distribution bar graph is created also in the window showing the 
distribution of street centerline lengths. This is more useful for datasets that contain 
information such as population. Below is an example from a Census dataset showing 
a frequency distribution of population per square mile. 
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6. Leave the Selection Statistics window open, return to the map and select a large 

number of street centerline using the Select Features tool . As soon as the 
selection is performed, notice how the Selection Statistics window is automatically 
updated with the new selection statistics. 

 

 
 
7. Another way to use a selection is to create a new layer from the selected features. To 

begin, set the Cities & Townships layer (in Government Units) as the only selectable 
layer and zoom to the entire extent of the layer. 
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8. Use the Select Features tool  to select several government units. 
 

 

 
 

9. In the Table of Contents, right-click on the Cities & Townships layer name, choose 
Selection and select Create Layer From Selected Features. 
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10. A new layer will be added to the Table of Contents that contains only the government 

units that were selected. This Layer is a temporary layer that only exists in your 
ArcMap project and does not alter the REGIS GIS data. 

 

 
 

11. Press the Clear Selected Features button  to remove the selection on the original 
Government Units layer. 

 
12. The symbology of the new layer can be changed by left-clicking on the symbol below 

the layer name in the Table of Contents. 
 

 
 

13. The layer can be removed from the project by right-clicking on the layer name in the 
Table of Contents and selecting Remove. 
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14. The concept of creating a new layer from selected features is useful when producing 

maps highlighting certain features. For example, select a group of parcels and then 
choose Create Layer From Selected Features. 

 

 
 
Additional Information  
See the Using selection layers and Displaying information about selected features 
sections of the ArcGIS Desktop Help manual. 

 
 

End of Exercise 8.5  
 

 

REGIS ArcGIS II Training ▪ Exercise 8.5 – Select By Location ▪ Page 6 



Exercise 9.1 – Introduction to Tables 
 
In this exercise, you will learn how to: 

♦ Open and navigate attribute tables 
♦ Select records in an attribute table 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Introduction to Tables Tutorial 

1. Right-click on the Cities & Townships layer name in the Table of Contents and 
choose Open Attribute Table. 

 

 
 
2. The attribute table for the Government Units layer appears in a new window. Along 

the top are field names such as Name, Unit Number, County, etc. Each record in the 
table is displayed horizontally below the field names. 
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3. To understand the one-to-one relationship between a record in the attribute table and 
a GIS feature, left-click on the gray box at the left-edge of one of the records. 

 

 
 

4. The entire row will be highlighted indicating that the record has been selected. Notice 
that the corresponding government unit is selected on the map. 

 

 
5. Right-click on the gray box again and select Zoom To to zoom the map to that 

government unit. 
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6. At the bottom of the attribute table, the number of selected records is displayed along 
with the total number or records. 

 

 
 

7. To add to your selection, hold down the CTRL key and select additional records by 
left-clicking on the gray box at the left edge. 

 

 
 

8. At the bottom of the window, choose the blue row button  to switch the attribute 
table to show just the selected features. 

 

 
 
9. Right-click on a record’s left edge again and select Identify. 
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10. The Identify window appears showing the field names and values for the government 
unit. Notice that the Identify window is simply another way of viewing a record from 
the layer’s attribute table. 

 

 
 
Additional Information  
 
See the Adding and viewing tables in ArcMap section of the ArcGIS Desktop Help 
manual. 
 

 
 

End of Exercise 9.1  
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Exercise 9.2 – Using Tables 
 
In this exercise, you will learn how to: 

♦ Sort, resize, hide, and freeze fields in an attribute table 
♦ Print and export all or portions of an attribute table 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Using Tables Tutorial 

1. Right-click on Freeway/Highway layer in the Street Centerlines group and select 
Open Attribute Table. 

 

 
 

2. Field widths can be adjusted by moving the mouse cursor to the divider between field 
names.  When the mouse cursor changes to the double-arrow 
icon ( ), left-click and hold and resize the column. 

 
3. Resized columns remain in the attribute table even if you close and reopen it. Use the 

Table Options button at the top left of the window to select Restore Default 
Column Widths to return every column to its original width. 
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4. Individual fields can be highlighted by left-clicking on the field name. 
 

 
 
5. Right-click on the Street Name field and select Sort Ascending. All the records in 

the attribute table are sorted alphabetically by street name. 
 

 
 
6. Right-click again on Street Name and select Freeze/Unfreeze column. The Street 

Name field immediately jumps to the far left side of the attribute table and is now 
locked in place. Scroll right using the bottom scrollbar and notice how the field 
remains visible while all other fields move. 
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7. Select Freeze/Unfreeze column again to remove the locked field. 
 
8. Individual fields can be turned off. Find the Alternate Prefix Direction field and 

right-click on the field name. Choose Turn Field Off to not show it in the attribute 
table. 

 

 
 

9. Turn all hidden fields back on by going to the Options menu and choosing Turn All 
Fields On. 
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10. Open the attribute table of the Cites & Townships layer in the Government Units 

group and select a group of records. An easy method for selecting multiple records is 
to left-click and hold on the gray box at the left edge of a record and drag up or down. 

 

           
 
11. Left click the Switch Selection button . All unselected records are selected while 

the original selection is cleared. 
 
12. An attribute table can be printed by opening the Options drop down menu  and 

choosing Print. It is good practice to first turn off all unnecessary fields and set the 
printers page orientation to landscape to avoid rows being printed across multiple 
pages. 
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13. Use the Advance Options tab of the Print window to choose whether all records or 

just the selected records will be printed. 
 

 
 
 

14. Attribute tables can also be exported to several file types, including Access tables, 
text files, and dBase (DBF). Press Options and select Export. 
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15. The Export Data window appears. The Export drop-down box allows you to choose 

whether to export all records or just the selected records. Use the folder icon to select 
an export location and file type. In most situations, set the Save as type as dBASE 
table. 

 

     
 

16. The exported dBase file can now be opened in Excel and modified as needed. It is 
good practice to immediately save the file as an Excel worksheet (.xls) instead of 
trying to overwrite the dBASE. 
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Additional Information  
 
See the Displaying tables and attribute information section of the ArcGIS Desktop Help 
manual. 
 

REGIS ArcGIS II Training ▪ Exercise 9.2 – Using Tables ▪ Page 7 



 
 

End of Exercise 9.2 
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Exercise 9.3 – Using Field Properties and MapTips 
 
In this exercise, you will learn how to: 

♦ Control field visibility in the Layer Properties window 
♦ Setup and customize MapTips for a layer 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Using Field Properties and MapTips Tutorial 

1. Right-click on the Parcels layer in the Table of Contents and select Properties. 
 

 
 

2. In the Layer Properties window, select the Fields tab. 
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3. All of the parcel fields are listed along with their alias names, types, and lengths. The 
checkbox next to each field indicates that the field will be visible when the attribute 
table is opened. Select Clear All and then place a checkmark by only the Parcel 
Number field. Press OK. 

 

 
 

4. Right-click on the parcels layer again in the Table of Contents and select Open 
Attribute Table. Only the parcel Number field in now visible. 
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5. Use the Identify Features tool  to select a parcel in the map and notice that only 
the Parcel Number field is visible here also. 

 

 
 

6. Move your mouse cursor over a parcel feature. After pausing, a box will appear next 
to your cursor displaying the parcel number. This is a MapTip that REGIS setup in 
the Parcels Layer Properties. 

 

 
 

7. Return to the Parcels Layer Properties window and select the Display tab. The PPN 
field (i.e. Parcel Number) should be selected as the Display Expression Field. The 
Display Expression Field is the field that is displayed as the MapTip. 
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8. The first checkbox controls whether MapTips are turned on or off. Uncheck the Show 
MapTips box and press OK. Return to the map and pause your mouse cursor over a 
parcel. The MapTips will not appear. 
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Additional Information  
 
See the Setting field properties, aliases, and table display options section of the ArcGIS 
Desktop Help manual. 
 

 
 
See the Displaying MapTips section of the ArcGIS Desktop Help manual. 

 
 

End of Exercise 9.3 
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Exercise 9.4 – Using Relates 
 
In this exercise, you will learn how to: 

♦ Access related information of the parcels layer, including owner and address, legal 
description, and sales history. 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Introduction to Tables Tutorial 

1. Use the Identify Features tool  to identify a parcel. 
 

 
 

2. REGIS has setup predefined relates that can be accessed by left-clicking on the plus 
icon next to the identified parcel. 
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3. The names of each related table will appear below. The related tables with a plus icon 
indicate that there are one or more records that relate to the identified parcel. 

 

 
 

4. For example, select the CADASTRAL_EQ_NAME_ADDRESS plus icon to view 
the related record containing the address and owner information of the parcel. The 
field names and values of the related record appear in the right-side of the window. 
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5. Identify another parcel and view the related record in the 
CADASTRAL_EQ_LEGALS table. Here you can view the legal description for the 
identified parcel. 

 

 
 

6. Identify other parcels to locate one that has a plus icon next to the 
CADASTRAL_EQ_SALES related table. Expanding that relate will show the sales 
history of the parcel. Since relates allow for a one-to-many relationship, there often 
will be multiple sales records for the parcel. 

 

 
 

REGIS ArcGIS II Training ▪ Exercise 9.4 – Using Relates ▪ Page 3 



Additional Information  
 
See the About joining and relating tables section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 9.4 
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Exercise 9.5 – Creating and Using Joins 
 
In this exercise, you will learn how to: 

♦ Use ArcCatalog to preview an Excel spreadsheet 
♦ Create a join between a GIS layer and an Excel spreadsheet 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Creating and Using Joins Tutorial 

1. Select the ArcCatalog  button on the Standard toolbar. Navigate to the  
 
REGIS I: Drive directory and locate the Excel spreadsheet named GovUnitsCensus.xls. 
 

 
 
2. Double left-click on the name to view the contents of the spreadsheet. Two entries 

should appear. Sheet1$ is the entire Excel worksheet while CensusData is a 
named range setup in Excel to capture a specific set of rows and columns. 

 

 
 

3. Select CensusData and switch to the Preview tab. A table will be displayed 
showing Government units along with their REGIS unit number, population, and 
median household income from the 2000 Census. Notice there is only one record 
per township. 
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4. In order to make a map of population or income, this Excel table must be joined 

to the Government Units layer in ArcMap (a join is used because there is a one-
to-one relationship). Return to ArcMap and locate the Government Units layer in 
the Table of Contents. Right-click on the layer name and choose Joins and 
Relates and then select Join. 
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5. The Join Data window appears. Complete the following steps to setup a join 
between the Government Units layer and the Excel spreadsheet. 

 
a. Make sure the first 

drop-down box is set 
to Join attributes 
from a table. 

 
b. Under step 1, select 

Unit Number as the 
field that the join will 
be based upon. 

 
c. In step 2, use the 

folder icon  to 
navigate to the 
location of the 
GovUnitsCensus.xls, 
select the 
CensusData table 
and press Add. 

 

 
 
d. In step 3, select 

UNIT_NUM as the field in the table to base the join on. The NAME field 
could also be used but it is best to use the shorter field to avoid potential 
mismatches because of spelling errors. 

 
e. Press OK to close the window and create the join. 
 

6. To ensure the join was successful, use the Identify Features  tool to select a 
Government Unit. At the bottom of the Field and Values window, there should be 
four additional fields all starting with the CensusData prefix. This indicates that 
the matching record from the Excel spreadsheet has been joined to the appropriate 
government unit. 
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7. The join also appears in the attribute table. Right-click on the Cities & 
Townships layer and select Open Attribute Table. 

 

 
 

8. Scroll to the right end of the attribute table and notice the fields appear here as 
well. ArcMap now considers them part of the regular attribute table so they can be 
used for sorting, freezing, turning on/off, selecting, etc. 
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9. Joining fields can also be used for symbology. This will be discussed in section 

10 but as an example, the Government Units layer could now be colored based on 
the median household income value (shown below) or population. 

 

 
 

10. The join can be removed by right-clicking on the Cities & Townships layer and 
selecting Joins and Relates, then Remove Join(s) and select Sheet1$. 
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Additional Information  
 
See the Joining tables section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 9.5 
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Exercise 9.6 – Creating Graphs 
 
In this exercise, you will learn how to: 

♦ Create a graph showing the population of government units 
 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Theme 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. Use exercise 9.5 to create a join between the Cities & Townships layer and the Excel 
spreadsheet containing the sample census data. 
 
Introduction to Tables Tutorial 

1. Set the Cities and Townships layer as the only selectable layer. 
 

 
 

2.  Use the Select Features tool  to select a small group of government units. 
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3. Open the attribute table of the layer Cities & Townships. Select the  Table 
Options button and click Create Graph. 

 
              

 
 

4. The Create Graph Wizard appears. In order to 
create a population bar graph of the selected 
government units, complete the following steps. 

 
a. Make sure the Graph Type is set to 

Vertical Bar and the Layer/Table drop-
down box is set to Government Units. 

 
b. Select CensusData.Population as the 

Value field. 
 
c. In the X field drop-down box, select 

Name and choose Ascending. 
 
d. In the X label field drop-down box, 

select Name. 
 
e. In the Color drop-down box, select 

Palette and choose a color scheme in the 
adjacent box. 

 
f. Press Next to go to the second setup 

screen. 
 

g. Select the option named Show only 
selected features/records on the graph. 

 
h. In the General graph properties box, 

change the Title value to something 
more appropriate like Population. 

 
i. Move down to the Axis Properties tabs 

and change the Left axis title to just 
Population. Switch to the Bottom tab 
and uncheck the Visible checkbox. 

 
j. Press Finish and the graph is displayed 

in its own window. 
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5. The graph is not static. It is a live-link with the selected features in the map. Leaving 
the graph window open, return to the map and select a different set of government 
units. The graph will automatically update showing the populations of the new units 
selected. 
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6. Right-click anywhere in the graph window to display more options, including the 

ability to Print to the graph. 
 

 
 

7. Close the graph using the x icon in the upper-right corner of the window. To return to 
the graph, go back to the View menu, choose Graphs and select Manage options. 

 

 
 

8. The Graph Manager window opens displaying a list of graphs created in the ArcMap 
project. Double left-click on a graph to re-open it or use the Delete button  to 
remove it. 
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Additional Information  
 
See the Looking at data with graphs section of the ArcGIS Desktop Help manual. 

 

 
 

End of Exercise 9.6 
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Exercise 9.7 – Creating Reports 
 
In this exercise, you will learn how to: 

♦ Create a report for a group of selected parcels 
 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Parcels with Name and Address layer into 
the data frame. 
 
Creating Reports Tutorial 

1. Use the Select Features tool  to select a small group of parcels. 
 

 
 

2. Go to the View menu, select Reports and select Create Report. 
 

 
 

3. The Report Properties window appears with the Fields tab selected. In the Available 
Fields box, use the right arrow  to move the Parcel Number and Owner Name 
fields into the Report Fields list box. 
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4. Left click Dataset Options and click the radio button next to Selected Set. 
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5. Left click Next twice and set the OWNERNAME field to sort Ascending. 
 

 
 

6. Left click Next three times and Type in a title for the report and click Finish. 
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7. Press the Generate Report button at the bottom of the window. The finished report 
will be displayed in a new window. 

 

 
 

8. Press the Print button at the top of the window to print the report. 
 
9. Press the Export button to save the report to a PDF. 

 
10. Close the report to return to the Report Properties window. Press the Save button and 

a Save Report window opens. The report can be saved to a file and loaded into 
another ArcMap project. Unlike a graph, a report is static and the saved report 
contains all the records involved. So it can be loaded into another ArcMap project 
that does not contain the Parcels with Names and Addresses layer. 

 

 
 

11. ArcMap’s reporting capabilities are somewhat limited and can be frustrating to a new 
user. An alternative approach is to export the attribute table of a layer to a dBASE 
(DBF) file, open it and create your own report layout and formatting in Excel. See 
exercise 9.2 for instructions on how to export an attribute table. 
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Additional Information  
 
See the Creating Reports section of the ArcGIS Desktop Help manual. 
 

 
End of Exercise 9.7 
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Exercise 10.1 – Introduction to Layer Symbology 
 
In this exercise, you will learn how to: 

♦ Change a layer’s symbology and transparency 
 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Introduction to Layer Symbology Tutorial 

1. Right-click on the Cities & Townships layer name in the Table of Contents and 
select Properties. Switch to the Symbology tab. 

 

 
 

2. The layer is setup with the simplest form of symbology where every government unit 
has the same symbol. Notice that in the Show box this is referred to as Single 
Symbol. 
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3. Left-click inside the symbol graphic in the main area to open the Symbol Selector 
window. 

 

 
 

4. ArcMap comes with hundreds of predefined symbols to choose 
from. Select the symbol named Medium Sand. 

 
5. You can also customize the symbol by using the Options box on 

the right side of the window. The fill color, outline, and width 
can be changed. 

 
6. Press OK twice to return to the map with a new symbology for 

the Government Units. 
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7. In the Table of Contents, left-clicking in the symbol image provides a shortcut 
directly to the Symbol Selector window.       

 
8. Return to the Layer Properties of the Government Units layer and select the Display 

tab. There is a Transparent text box that is initially set to 0%. Change the number to 
50% and press OK. 

 

 
 

9. With the Government Units now semi-transparent, it allows other layers underneath it 
to show through. 
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Additional Information  
 
See the Drawing all features with a single symbol and Drawing a layer transparently 
section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 10.1 
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Exercise 10.2 – Advanced Layer Symbology 
 
In this exercise, you will learn how to: 

♦ Setup layer symbology based on unique attribute values or groups of values 
♦ Setup layer symbology to display pie charts 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Introduction to Layer Symbology Tutorial 

1. Open the Layer Properties of the Freeway/Highway layer and switch to the 
Symbology tab. Instead of using the Single Symbol classification, notice that the 
Show box is set to Unique values. 

 

 
 

2. The streets are color-coded using the Subtype field (see the Value Field drop-down 
box). Each value has a separate symbol that can be changed individually by left-
clicking on the symbol. 

 
3. Left-click the Count column 

heading. The question marks will 
be replaced with the actual 
number of street centerline 
segments in each category. 
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4. Close the Layer Properties window and return to the map. To create your own unique 
values symbology, open the Layer Properties for the Government Units layer. 

 
5. In the Symbology tab, complete the following steps: 

 
a. In the Show box, select the Unique values option under the Categories 

heading. 
 
b. In the Value Field drop-down box, select County. 

 
c. Press the Add All Values button at the bottom of the window. All of the 

possible counties in and around the REGIS area will be added as separate 
categories. 

 
d. Left-click the Count column heading to see which categories actually have 

government units in the GIS data. Only Kent County and Ottawa County 
should have counts above 0. 
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6. Since most of the County categories are empty, they should be removed. Hold down 
the CTRL key and left-click on each row with a count of 0. Once they are all 
highlighted, right-click on the highlighted rows and choose Remove Value(s). 

 

 
 

7. The first row in the symbol list is always <all other values>. Since this count is also 
0, go ahead and remove the checkmark next to the symbol. 

 
 

 
8. Change the symbol color of the remaining two categories and then press OK. The 

map will refresh with the government units now color-coded by county. 
 

 
 

9. The Table of Contents will also update with the new symbology. 
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The rest of the exercise relies on a join that was setup in exercise 9.5. If the CensusData 
join is not present in the Government Units layer, return to exercise 9.5 to create the join. 
 
10. Return to the Symbology tab of the Government Units layer. You will now setup a 

graduated color symbology by completing the following steps: 
 

a. In the Show box, select Graduated colors under the Quantities heading. 
 
b. In the Fields box, set the Value to CensusData.POPULATION. 

 
c. In the Classification box, note that classification type is Natural Breaks. 

Change the Classes drop-down box from 5 to 7. 
 

d. In the Color Ramp drop-down box, choose a color scheme that will display 
the population groups appropriately. 

 

 
 

e. Press OK to return to the map with the Government Units now color-coded 
by population. 
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11. Return to the Symbology tab and select the Classify button. 
 

 
 

12. Change the Classification Method to Equal Interval. 
 

 
 

13. Press OK twice and notice how changing the classification method greatly affects 
how the population is represented on the map. 
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14. Return to the Symbology tab for the Government Units layer. You will now setup a 
pie chart symbology displaying both population and median income using the 
following steps: 

 
a. In the Show box, select the Pie option under the Charts heading. 
 
b. In the Field Selection box, move both the POPULATION and 

MED_INCOME fields over into the symbol area. 
 

c. Left-click on the symbols to set appropriate colors. 
 

 
 

d. Press OK and each government unit is drawn on the map with a pie chart 
inside of it. Zoom in to eliminate the clutter and get a better view of the pie 
charts.* 

 

 
*This is just a demonstration on using pie charts. Population and median income don’t have 
comparable values unless some form of standardization is performed first. 
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Additional Information  
 
See the Applying symbology section of the ArcGIS Desktop Help manual. 
 
 

 
 

End of Exercise 10.2 
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Exercise 10.3 – Labeling Features 
 
In this exercise, you will learn how to: 

♦ Turn labels on or off 
♦ Set which attributes are used for labeling 
♦ Customize the label placement settings 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Introduction to Layer Symbology Tutorial     

1. Labeling for any layer is easily controlled by 
right-clicking on a layer name in the Table of 
Contents. There is a Label Features that 
displays a checkbox when labeling is turned on. 
If it is missing, left-click on the Label Features 
text and the checkbox will be added and the map 
will redraw with labels. 

 
2. Turn off all layers except for the street centerlines. Zoom in on the map to an area 

where a small portion of the street centerlines are visible. Make sure labeling is 
turned on for the street centerlines. 
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3. Open the Layer Properties for the Street Centerlines and switch to the Labels tab. 
 

 
 

4. In the Text Symbol box, the font type, size, and color can be changed. Set the font 
size to 14. 

 
5. In the Text String box, note that the Street Name field is used to display the labels 

on the map. 
 

6. The Street Name attribute does not 
contain the prefix (e.g. N, S, E, W) or 
the street type (e.g. RD, DR, PKWY, 
etc) but it may be useful to display these 
as well on the map. ArcMap allows for 
multi-field labels through the use of an 
expression. Select the Expression 
button in the Text String box. 

 
7. The Label Expression window appears. 

Put your mouse cursor in the Expression 
text box and manually delete the 
[STREET_NAME] text so the entire 
box is blank. 
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8. In the top box that lists all the fields in the Street Centerlines layer, double left-click 
on the Prefix_Direction field to add it to the expression. Then single left-click on the 
Street_Name field to highlight it in the top box. Press the  
Append button. The expression should now look like this: 

 
[PREFIX_DIRECTION] & “ ” & [STREET_NAME] 

 
9. Repeat the append process to add the STREET_SUFFIX and 

SUFFIX_DIRECTION fields to the expression so the final expression reads: 
 

[PREFIX_DIRECTION] & “ ” & [STREET_NAME] & “ ” & [STREET_SUFFIX] & “ ” & [SUFFIX_DIRECTION] 
 

 
 

10. Press OK twice and the labels on the map will change to include the full street name. 
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11. Return to the Labels tab for the Street Centerlines layer. Select the Placement 
Properties button inside the Other Options box. The placement Properties window 
appears with two tabs. Make sure the Placement tab is selected. 

 
12. In the Orientation box, switch from Parallel to Curved. In the Position box, 

uncheck the Above option and place a checkmark in the On the line option. 
 

 
 

13. Press OK twice and note how the labels have changed in the map. They should 
appear directly on top of the line and curved where needed. 

 

 
Additional Information  
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See the Working with text section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 10.3 
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Exercise 10.4 – Creating a Definition Query 
 
In this exercise, you will learn how to: 

♦ Create a definition query to only display certain features in a layer 
 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Creating a Definition Query Tutorial 

1. Right-click on the Cities & Townships layer name in the Table of Contents and 
select Zoom To Layer.  

 →  
 

2. Right-click on the Cities & Townships layer again and select Properties. Switch to 
the Definition Query tab. The definition query box is empty indicating that the entire 
layer is being displayed. 
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3. Select the Query Builder button to open it in a new window. In this exercise, you 
will create a definition query to show only those government units that appear in 
Kent County. 

 
a. Double left-click on the 

County field to add it to the 
expression box at the 
bottom. 

 
b. Left-click on the equals sign 

button. 
 

c. Left-click on Get Unique 
Values. 

 
d. Double left-click on Kent 

County to finish the 
expression: 

 
COUNTY = ‘Kent County’ 
 
 
 
 

4. Press OK twice to return to the map. The map will refresh and only show 
government units in Kent County. Remember that a Definition Query does not alter 
the data in any way. ArcMap is simply using a filter to exclude Ottawa County 
government units in your project. 
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5. To remove the definition query, return to the Definition Query tab. The query 
expression should automatically be highlighted. Press the DELETE key and the 
expression box is emptied. Press OK to return to the map and all the government 
units should now appear. 

 

→  
 
Additional Information  
 
See the Displaying a subset of features in a layer of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 10.4 
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Exercise 10.5 – Creating a Layer File 
 
In this exercise, you will learn how to: 

♦ Create a definition query to show only government units that are cities 
♦ Save a layer file and add it back into an ArcMap project 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Creating a Layer File Tutorial 
 
This exercise includes techniques from exercises 8.2 (Select By Attributes) and 10.4 
(Creating a Definition Query). Please review those for more details. 
 

1. Right-click on the Government Units layer name in the Table of Contents, select 
Properties and switch to the Definition Query tab. 

 

 
 
2. Select the Query Builder button and create the following query: 

NAME LIKE ‘%City%’.  
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3. Press OK and the map will refresh showing only the government units that are cities. 
 

 
 

4. Rename the layer to Cities by highlighting it in the Table of Contents, pressing F2 
and entering a new name. 

 

 
 

5. Right-click on the layer name and select Save As Layer File. 
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6. Navigate to your personal folder and save the file as Cities.lyr. Remember that a layer 
file does not contain any data. It only saves the layer properties (e.g. labeling, 
symbology, definition query, etc) of a dataset. 
 

 
 

7. Press Save and a layer file is created that can be added to any ArcMap project. 
 

8. To demonstrate adding a layer file, first remove the existing Cities layer. Right-click 
on the layer and select Remove.  

 

 
 

9. Select the Add Data button  located on the Standard toolbar. 
 
10. Navigate to the location of the layer you saved, highlight it and press Add. 
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11. The layer is added back into ArcMap with the definition query already setup to 
display only cities. 

 

 
 

Additional Information  
 
See the Saving a layer to disk section of the ArcGIS Desktop Help manual. 
 

 
End of Exercise 10.5 
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Exercise 11.1– Layout View Overview 
 
In this exercise, you will review how to: 

♦ Create a map in layout view 
♦ Insert map elements including a title, text, north arrow, scale bar, and legend 
♦ Print or export a map. 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. 
 
Layout View Overview Tutorial 

1. Determine the type of map you want to create and setup the appropriate symbology. 
Shown below are the REGIS Government Units color-coded by population. 

 

 
 

2. Remember that ArcMap has two views – Data View and Layout View. Use the icons 
in the lower-left corner of the map to switch between the views. Alternatively, go to 
the View menu and choose Layout View. 

 

 or  
 

3. To change the page size or orientation, go to the File menu and choose Page and 
Print Setup. 
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4. Use the Layout Toolbar to navigate around the page. 
 

 
 

5. Go to the Insert menu and select Title and type a title for the map. 
 

 
 

6. Go to the Insert menu and choose Text to add more text boxes to the map. 
 

 
 

7. Go to the Insert menu and choose North Arrow. Pick an arrow style and add it to 
the map. 

 

 
 

8. Go to the Insert menu and choose Scale Bar. Pick a scale bar style and add it to the 
map. 

 

 
 

9. To modify any element on the page, use the Select Elements tool  to highlight it 
and then modify its size. Right-click on an element and select Properties to change 
its style. 
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10. Go to the Insert menu and choose Legend. Complete the wizard to add a legend to 
the Layout View. 

 

 
 

11. A completed map may look something like this. 
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12. The Layout view can be printed or exported to a file format such as PDF. Both 
options are found in the File menu.  
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Additional Information  
 
Review exercises in Section 4 of the ArcGIS I Training Class or read the Page layout and 
map composition section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 11.1 
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Exercise 11.2– Adding Reference Systems 
 
In this exercise, you will review how to: 

♦ Add latitude/longitude lines or a grid to a map in layout view 
 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. Switch to the layout view. 
 
Layout View Overview Tutorial 

1. Using the Select Elements tool , right-click on the map’s data frame and choose 
properties. 

 

 
 

2. Switch to the Grids tab. It should be empty indicating that no reference systems have 
been added to the map. Select the New Grid button. 

 

 
REGIS ArcGIS II Training ▪ Exercise 11.2 – Adding Reference Systems ▪ Page 1 



3. The Grids and Graticules Wizard appears. Select the Graticule option in the first 
box. 

 

 
 

4. Press Next three more times to continue through the wizard. The default values are 
all acceptable but observe the various customization options that are available. Press 
Finish and the reference grid appears in the list named Graticule.  
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5. Press OK and a latitude/longitude grid will be overlaid on the data frame. It may be 
necessary to reduce the size of the data frame if the latitude labels on the sides extend 
beyond the page margins. 

 

 
 

6. Use the Zoom In tool  on the Layout Toolbar to zoom into the top edge of the 
data frame to clearly see the labels. In this example, lines of longitude are placed 
every 10 minutes (10’). 
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7. Return to the Data Frame Properties and the Grids tab. Press the Remove Grid 
button to delete the reference system from the project. 

 
8. Press New Grid and this time select the Reference Grid option. 

 

 
 

9. Press Next three times to continue through the wizard. The default values are all 
acceptable but observe the various customization options that are available. Press 
Finish to add this grid to the list named Index Grid. 
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10. Press OK and a reference grid is drawn around the data frame. 
 

 
 

Additional Information  
 
See the Grids and graticules section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 11.2 
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Exercise 11.3 – Aligning Elements in Layout View 
 
In this exercise, you will learn how to: 

♦ Snap elements to grids 
♦ Use guides to align elements 
♦ Align elements to each other 
♦ Group elements 

 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. Switch to the layout view. 
 
Layout View Overview Tutorial 

1. Go to the View menu and select Grid. A grid of dots will appear on the page to aid in 
aligning map elements. 
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2. Go to the Customize menu and select ArcMap Options. In the Options window that 
appears, switch to the Layout View tab. 

 

                 
 

3. In the Snap elements to box at the bottom, place a checkmark by Grid. Press OK to 
return to the layout view. 

 

 
 

4. Use the Select Elements tool  to select a map element and left-click and hold to 
move it around the page. Notice that with snapping to grid enabled, the element snaps 
easily to the dotted grid. Snapping to the grid also works when resizing elements. 
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5. Return to the Options menu and the Layout View tab. Uncheck Show in the Grid 

box to turn off the grid. Also uncheck Grid in the Snap elements to box. 
 

 
 

6. Guides are another method for aligning elements in the Layout View. Move your 
mouse cursor into the Ruler area at the top or left areas of the layout view and left-
click. A small arrow will appear at the click point while a thin blue line will be drawn 
vertically or horizontally on the page. 

 

 
 

7. Again use the Select Elements tool  to move or resize elements to match the 
guide lines. 
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8. To remove a guide, right-click on the arrow and select Clear Guide. 
 

 
 

9. Right-click anywhere in the ruler and choose Clear All Guides to remove all guides. 
 

 
 

10. Map elements can be aligned to each other using the Select Elements tool . Select 
an element and then hold the SHIFT key to select more elements. Right-click on any 
of the elements and select Align and then choose the type of alignment. For example, 
select Align Left. 

 

REGIS ArcGIS II Training ▪ Exercise 11.3 – Aligning Elements in Layout View ▪ Page 4 



 
 
 

11. The map elements will align with each other. 
 

 
 

12. When multiple elements are selected, it is also possible to group them together for 
easier manipulation on the page. Right-click on the selected elements and choose 
Group. 
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13. The elements become a single element that can be moved, snapped, or aligned 
together. 

 

 
 
 
 

14. Right-click on the grouped element and choose Ungroup. 
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Additional Information  
 
See the Page layout and map composition section of the ArcGIS Desktop Help manual. 
 

 
End of Exercise 11.3 
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Exercise 11.4 – Using the Draw Toolbar 
 
In this exercise, you will learn how to: 

♦ Use the Draw toolbar to add text and shapes to the Layout View 
 
Setup 
 
Log in to the REGIS Application Web Interface and launch ArcView 10. Use the Layer 
Manager button on the REGIS toolbar to add the Basic Layers (Group Layer) to the data 
frame. Switch to the layout view. 
 
Using the Draw Toolbar Tutorial 

1. Turn on the Draw toolbar by going to the View menu, choosing Toolbars and select 
Draw. 

 

 
 

2. The Draw toolbar contains a variety of tools to assist in creating a page layout. It also 

contains the same Select Elements tool  that appears in the Tools toolbar. 
 

 
 

3. Use the Select Elements tool  to highlight a text box. Return to the Draw toolbar 
and use the font controls to change the font type, size, style, and color. 
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4. Select the New text drop-down box and pick the A icon to add regular text to the 
layout view. This is the same as going to the Insert menu and choosing Text. 

 

 
 

5. Select the Callout option  to add a text callout box to the page. Note that if you 
do place a text box on top of the data frame, it will not stay in the correct spot if the 
map extent is changed. When you do need the callout box to move with the map, 
switch back to data view and add graphics onto the map. 

 

 
 

6. Select the new shape drop-down box and pick New Rectangle. 
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7. On the page, left-click to draw a rectangle and double left-click to finish the shape. If 
needed, first create some guides to use in aligning the rectangle. 

 

 
 
 
 

 
8. A new shape will always appear on top of the other map elements. Right-click inside 

the rectangle. Select Order and then choose Send to Back. 
 

 
 

9. The shape is moved underneath the other elements. 
 

 
 

10. Right-click on the shape again and select Properties. The Properties window appears 
where the fill and outline colors can be adjusted. Set the Fill Color to No Color and 
press OK. 
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Additional Information  
 
See the Drawing points, lines, and circles section of the ArcGIS Desktop Help manual. 

 

 
 

End of Exercise 11.4 
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